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Introduction 

The JBC Remote Manager program is part of the Open Manager environment and allows you to monitor 
and configure JBC stations connected to Station Controller PCs through USB connector or JBC stations 
with Ethernet connections. These stations are controlled by the JBC Host Service program installed in the 
Station Controller PC. 

The JBC Remote Manager program uses JBC Connect Remote Library DLL to communicate with Station 

Controllers.  

For USB connections, the proper USB to UART bridge driver must be installed in the Station Controller PC. 
This driver is provided with the JBC Host Service distribution. 

System Requirements 

Operating System: Windows Vista/ 7 / 8 / 8.1 with NET Framework 4.5.1 

Processor: Intel i3 

RAM: at least 1GB, 2GB recommended 

Hard disk: 2MB available hard disk space 

NET Framework 4.5.1 

Supported Operating System 

Windows 7 Service Pack 1 

Windows 8 

Windows Vista Service Pack 2 

Download and install NET Framework 4.5.1 

Microsoft NET Framework 4.5.1 (Web Installer), requires an Internet connection. 

Microsoft NET Framework 4.5.1 (Standalone Installer) 

 

  

https://www.microsoft.com/en-US/download/details.aspx?id=40773
https://www.microsoft.com/en-US/download/details.aspx?id=40779
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Supported Stations 

The JBC stations supported by the Open Manager environment are listed below. The minimum station 
program version needed is showed for each station model. 

 

Station Minimum program 
version needed 

DM 9996761 

DD 9996762 

DDR 9996779 

DI 9996763 

HD 9996764 

HDR 9996780 

CD/CF 9996765 

CS/CV 9996766 

CP 9996767 

NA 9996768 

DDE, HDE, 
DME, NAE  

All 
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Program Description 

The Remote Manager program allows you to perform the following tasks: 

 Monitor active stations connected to Station Controller PCs by USB or Ethernet connectors  

 View and modify station settings 

 Save, load and print station settings 

 Perform settings changes to several stations at once  

 Plot station temperature and power data 

 

Main Window 
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At startup, the Remote Manager program shows all connected stations in the Station List, on the right.  

 

 

A Station Window appears by double clicking on a station icon in the Station List.  
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Menu 

 

File 

 

To load a Configuration File previously saved.  

See "Load/Save Settings Panel" in page 19 and "Settings Manager" in page 25 to learn how to load, save 

and apply configuration settings. 

View 

 

View - Languages 

 

View – Temperature Unit 

 

You can view temperature in Celsius or Fahrenheit in JBC Remote Manager windows. 

Tools 

 

Settings Manager opens an empty Settings Manager window. 

See "Settings Manager" on page 25 to learn how to modify station settings in a massive change. 

Register Manager opens an empty plot area to register temperature and power data of stations. 

See "Register Manager - Plotting" on page 32 to learn how to plot station data into a graphic. 

Windows 
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Station List 

The Station List show stations as list format and tree format: 

 List format shows all connected stations 

 Tree format allows you to group stations for better managing them 

List format 

The List format shows all the connected stations as icons or table format. 

 

Each station icon shows the station name and model, and the software version installed. 

Tree format 

The tree format allows you to group stations for better managing them. 

 

The Manager program maintains the groups and stations you define in it. 

Note: Stations showed in blue text, are connected stations. 

Station List Popup Menu 

Right clicking in a station, it appears a popup menu. 
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 View Parameters: it opens a window containing the station data and settings. It is the same as 

double clicking. 

 Print Current Settings: it shows a window with the station settings. You can print the station 
settings from that window. See an example in "Printing Settings" in page 26. 

 Add Plot Serie: To add series to a new plotting window. See "Register Manager - Plotting" on page 

32 to learn how to plot station data into a graphic. 

 Control Mode and Monitor Mode: To change station settings, you must enter in Control Mode. The 
program will ask you the station password. See "Monitor and Control Modes" in page 13. 

Station List Position and Style 

Use the Panel Position icon to change the position and style of the Station List 
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Both formats can be viewed in the Station List panel, by selecting "List" and "Tree".  
 

 
 

Grouping stations 

You can create groups of stations by selecting the root element "Station List" or group, and choosing 

"New Station Group" option from the popup menu. A new group is added and you can change its name. 

 

 
 

Then, drag a station to the group. 
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Station Window 

The Station Window has the station data and settings grouped by panels. You can switch between these 
panels by clicking on the icons at the top of the window. 

  

The panels are the following: 

 

 Work Panel 

 Station Settings Panel 

 Tools Settings Panel 

 Load/Save Settings Panel 

 Reset Station Settings Panel 

 Counters Panel 

 Station Data Panel 
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Monitor and Control Modes 

Each station has two Modes:  

 In Monitor Mode you can only view data and settings. You cannot change settings. 

 In Control Mode you can change some station settings. 

To switch between Monitor and Control mode click on the lock icon.  

 

To enter in Control Mode, you must enter the password (station PIN Code). 
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Work Panel 

The Work Panel shows the selected port, an image of the connected tool and the actual temperature and 

power. 

You can change the selected temperature by clicking in the -5 or +5 icons. 

 

Switching to other Port 

To switch to other port, click on the "Port x" rectangle and select another port. 
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Work Panel with Temperature Levels 

If the selected port is configured with a temperature level, you will see the levels and the current selected 
level. 

You can change the selected level by clicking on the desired level. You can switch to a level to already 
have a temperature defined in it.  

 

 

Work Panel with Fixed Temperature 

If the selected port is configured with a fixed temperature, you will see the selected fixed temperature. 
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Sleep or Hibernation Status 

If the station enters in a Sleep or Hibernation status, the following data will be showed. 
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Station Settings Panel 

This panel contains station settings. You can change all of them. 
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Tools Settings Panel 

This panel shows Port/Tool pairs settings 

The ports are showed at the right edge and the tools are showed at the top of the panel. 

You can change all the settings. 

 

Current connected tool in the selected port is showed with a  near of the tool image. 
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Load/Save Settings Panel 

You can save the current station settings to a configuration file.  

Also, you can load a configuration file into the station, setting all compatible station and tools values. 

Although, we recommend that you use the Settings Manager tool, where you can select which settings 
will be loaded into the station. See "Settings Manager" in page 25. 
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Reset Station Settings Panel 

This panel allows you to reset the station settings to the factory values. 
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Counters Panel 

This panel shows you the counters associated to each port. 

You cannot change these values. If the station supports partial counters, you can rest them to zero. 
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Station Data Panel 

This panel shows you station data that you cannot change. 

 

Modifying Station Settings 

Some values are values that should be written, like the station name or the temperature values.  

Others are "switching" values that change simply by clicking on it, like On/Off values, selected 
temperature level or delays.  

Editing settings 

When you click over a setting, an edit textbox appears to enter the new value. Press Enter to end the 
setting edition. 

If you are editing the value and press the Escape key, the value will change to the original value. 

 

 

Editing switching settings 

For "switching" values, you will see a hand with a plus sign into it. If you click on the setting, the value 
will change to the following allowed value. 
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Pressing and maintaining pressed the Control key, the sign will change to a minus sign to indicate that 
the value will be set to the previous allowed. 

 

 

Station Graphics Panel 

This panel allows you to add series of this station data to be plotted in the Register Manager 

 

Select a plot window where you want to add series of this station, and press Add Series button. 

A Series window appears to add series of the selected station. 
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You can also add station series by: 

 Selecting the "Add Plot Serie" menu option of the Station List (to a new plotting window). 

 Dragging a station from the Station List (to an open plotting window). 

 

See "Register Manager - Plotting" on page 32 to learn how to plot station data into a graphic. 
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Settings Manager 

Selecting Tools -> Settings Manager or File -> Load a Configuration File menu options, the following 
window appears. 

 

This window allows you to load source settings on the left panel to be applied to stations listed on the 
right panel.  

Source settings appear as a tree and you can modify them previous to be applied to target stations. 



 

26 

Source Settings Panel 

 

Loading Settings 

You can load settings from a previously saved Configuration File, using the "Load from File" button, or by 
dragging a station from the Station List to load current settings of a connected station. 

Save Settings to Configuration File 

You can save the source settings tree and a Comment to a Configuration File by using the "Save to File" 
button.  

Printing Settings 

You can print the source settings, also. 

Selecting Settings to apply to target stations 

You must select the check boxes of the settings that will be applied to the stations listed on the right 
panel.  

By selecting a tree node, all the children nodes and it parents nodes will be selected. 

By deselecting a tree node, all the children nodes will be deselected. 
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Modifying Settings 

Some values are values that should be written, like the temperature values; others, are "switching" 
values, which change simply by clicking on it, like On/Off values, selected temperature level or delays.  

Editing Settings 

When you click over a setting, an edit textbox appears to enter the new value. Press Enter to end the 
setting edition. 

If you are editing the value and press the Escape key, the value will change to the original value. 

 

Editing Switching Settings 

For "switching" values, you will see a hand with a plus sign into it. If you click on the setting, the value 
will change to the following allowed value. 

 

Pressing and maintaining pressed the Control key, the sign will change to a minus sign to indicate that 
the value will be set to the previous allowed. 

 

Copying/Pasting Settings 

To simplify defining source settings, you can copy/paste some node data. 

First, define a node to be copied by selecting "Copy Node Settings" from the popup menu. 

You can use Ctrl+C keys. 
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The node will be marked as source node by changing its background color. 

 

Select other node and choose "Paste Settings" or "Paste Settings (only Checked)", if they are available. 

Selecting "Paste Settings" (Ctrl+V), all node settings will be copied to the target node. 

Selecting "Paste Settings (only Checked)" (Ctrl+M), only checked settings will be copied to the target 
node. 

You can change from "Paste Settings" to "Paste Settings and Checks" by clicking the Control key. 

"Paste Settings and Checks" option copies both the setting value and the check mark. 
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Target Stations Panel 

Once you have defined the source settings to be copied to target stations, you must select them in the 

"Target Station List" panel on the right. 

 

Listing and Filtering Target Stations 

Click "View Stations" button to list the target stations.  

You can filter the list by model or name. It is allowed use asterisks; for example, "Work*" will show 
stations like "Work01", "Work02", "WorkAAA", etc. 

Refresh the station list after entering a filter. 
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Selecting Stations and Ports 

After listing the target stations, you should assign which source port settings will be configured in target 
ports.  

In the following example, settings from port 1 will be applied to port 1 of stations Work01 and Work02. 

 

Applying Source Settings to Target Stations 

After target stations and ports selection, click on "Apply" button to copy source settings to target 
stations. 
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Viewing a Report 

After applying, you can view a report about what was applied. 

The report contains the selected source settings, the target stations and ports and any warning about 

problems when trying to apply settings.  
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Register Manager - Plotting 

Selecting Tools -> Register Manager, the following window appears. 

 

Control Bar 

 

File 

 New: Deletes the data currently recorded as well as the series created.  

 Open: It allows you to open a LBR file previously recorded with this program to redisplay a graph.  

 Save As: Saves the current graph in LBR format to view it afterwards.  

 Print: Print the graph displayed in the program.  

 Export to CSV: Export data series to a CSV (Comma separated value) to be processed by other 
programs. Temperature units written to the CSV file will be in the current temperature unit of the 
plot. 
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Configuration  

 Wizard: Sets the basic parameters to do a graph.  

 Series: Allows to add, edit and delete plot series. You can also add station series by: 

 Selecting the "Add Plot Serie" menu option of the Station List (to a new plotting window). 

 Dragging a station from the Station List (to an open plotting window). 

 Using the Wizard. 

 Selecting "Add Series" from Graphics tab of a station window (to a new or open plotting window). 

 Axis and Grid: It allows you to adjust the axes of temperature, power and time as well as the 
horizontal and vertical grids. This adjusts the ranges for the axes and the steps of the grids.  

You can also change de temperature units for the plot: Celsius (ºC) or Fahrenheit (ºF). 

 Options: You can set various options as well as the trigger.   

 Title: This option changes the title of the graph that is being displayed.  

 Templates: In this option you can load and save templates of graphs. 

Coordinates 

This button displays the values of the series. Pressing the button will display a popup window that 

will show the values of the series in the selected time. 

Zoom 

This button allows zooming a single axis either horizontally or vertically, or both axis 
simultaneously. After selecting an option, drag the mouse over the chart area to zoom in. 

Default Zoom 

 This button restores the plot zoom to the default value. 

Trigger Type 

It indicates the trigger type that is currently selected (Manual, Auto or Single). If trigger type 
is not Manual, “R” button resets the detection of the trigger. 

 

Record and Play Controls 

 Play: It plays the current graph. During playback, times listed to the right indicate the total recorded 
time and the current playback time.  

 Pause: It pauses playback or recording.  

 Stop: It stops current playback or recording  

 Record: It starts recording the data. Total recording time is showed at the right of the time bar. 
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Also there is a time bar to indicate the state of playback of the graph. The bar displays two notches to 
indicate the time window visible of the total time. So that the notch on the left corresponds to the left 

side of the graph area.  

If you click on the time bar, the plot area will show the selected time range. 

Plotting with the Wizard option 

Be sure that the station(s) you want to register are connected and appear in the station list. 

Add the desired series you want to plot.  

For each series to be added, select the station, the port of the station you want to plot, the magnitude 
(temperature or power) that you want to graph and the desired series name, and press the Add button. 

Once you added all series you want to plot, enter the title for the plot and press Next button. 

 

The axis and the grid configuration will be requested. 

From this window, you can select the desired temperature units for the plot (ºC or ºF). 
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Press Finish button to end the plot settings. 

Start recording by pressing the Record button. 

If you want to modify, add or delete a serie, or change the axles, you should go to Configuration / Series 
or Configuration / Axis and Grid. 

The recording can be paused and then up again. During the break, you will not get new values for the 
series.  

When you stop recording you can play and move about it by clicking on the time bar. 

Trigger 

The trigger specifies how the program starts recording.  

The trigger options and modes can be defined in Configuration / Options. 

 Manual: Recording begins when you press the Recording button and does not stop until you press 
the Stop button.  

 Single: Recording starts when you remove the tool from the stand and stops when it reaches the 
right edge of the graph area or time range is over, depending on your time axis settings. 

 Auto: Recording starts when you remove the tool from the stand and does not stop until you press 
the Stop button. 

You can use the Reset ("R") button in Single mode to re-enable the detection of the trigger. 
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History 

Version 0715 

First version 
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